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This document explains all the main functions of the application, plus the bundled Thread 
Editor utility, and Symbol Editor. 
We hope you enjoy many hours using the program! 
If you can't find the answer to a query you have within this document, please send 
us an email using the contact form on our website, or in the help menu of your program. 

Jeff & Deb Tullin - Ursa Software

MacStitch Mac, and WinStitch for the PC are designed for making the creation of 
counted cross stitch charts easy, quick and fun. 

You draw on screen using the mouse, using your selected colors (taken from the DMC, 
Anchor, Madeira or several other thread ranges), and build up your design just as you 
would on graph paper. 
For the artistically challenged, you can import scanned photos or clipart, and have the 
program turn them into ready-to-stitch designs in minutes, at just the right size. 
The printouts are clear and easy to read, especially when you choose to print at the larger 
symbol sizes. No need run down to the print shop to get the chart enlarged when you can 
print it yourself! 

 - �1



The task of creating a chart involves either designing something based upon an idea you 
have, and using the computer screen like a sheet of graph paper, or by importing an 
image from elsewhere (perhaps a photo or piece of clip art) 
Once the design is on the screen, you can amend it further: perhaps by adding text, 
removing background stitches, or adding half stitches to smooth curved edges. 
This manual explains all the main functions of the application, and the bundled Thread 
Editor utility, and Symbol Editor. 

Note the software is supplied in 3 levels: Lite, Standard, and Premium. 
Some of the features are not available in the Lite edition, and some are only available in 
the Premium edition.  
A table showing the differences can be found on our website. 
This manual covers all options: if you do not have the Premium edition, some of the 
options may not be available to you. 
If you are using a large screen, you will find that many of the dialogs used by the 
program can be dragged / resized to a larger size, and that text and buttons etc will grow 
larger to match. This can make small text easier to read. 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Contextual Help  
 
A “Contextual Help” window will open when you start the application. 

This window shows help and 
information about the thing you 
most recently clicked upon. 

It will open over the main window 
and can be moved to one side so 
that it provides help as you work. 

If you don't want it to appear, 
untick the ‘show context help’ 
checkbox at the bottom of the 
window. (It can be re-enabled in 
the preferences screen) 

The Launch Window

When the application is first opened, you will see a Quick Launch Window appear, which 
looks like this 
Here you have easy access to the  most common tasks you need to get started with the 
program. You can also open this at any time from the File menu. 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New   
..starts a new blank design, either with the last used settings or with all the options, 
shown below. 

Set the Stitches/in bar 
to the number of stitches 
per inch your design will 
be. 
Slide the Width and 
Height bars (or type in a 
number) to set the 
dimensions of the new 
chart. (The preview on the 
right will confirm how 
large your design will be) 
You can choose one of the 
3 Cloth Colour settings, 
or click on the palette icon 
to choose a custom color. 
There is a space to set the 
title of the new design. 
And you can also add an 

aperture (such as an oval frame) -the Aperture/Background option allows you to 
specify a cut-out shape, or apply a picture behind the grid (Onion skin)   

The background can be a picture (this is the same as the onion skin feature), or it can 
be an oval or rectangle. If you choose oval or rectangle, the text box next to the select 
will display ’10’  This is the size of the border, and you can change it to another 
thickness such as 6 if you wish. 
So if you start with a 100 x 100 design, and add an oval aperture with border of 6, 
your new design will be a 100 x 100 area, showing an aperture which is round, and 
which is 88 stitches across (allows 6 on each side) 
The whole design area can be worked upon: this background aperture is just a guide 
that you can choose to follow. 

Ticking the Add a Border option allows you to set a border around the design. There are 
some supplied, or you can create your own using the application. 
At the bottom of the dialog is a ’use these settings as default’ option.  
If this is ticked, you can quickly reuse these settings in the future by using the ‘default 
settings’ tick box on the New page. 

The ‘Keep Ratio’ tick box allows you to set a shape (eg 100 x 200) then tick the box. After 
that you can change the width and the height adjusts automatically. 
(This is more for use when the dialog is used to CHANGE the size of an existing chart) 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Import 
allows you to open a photo or clip art and convert it to a chart made up of full stitches, 
using either the Import Wizard or Advanced Importer if you have the Premium 
edition  (see “importing” later in this document) 

Open
is used to browse your computer for a  .CHART file previously saved. (the program uses 
files whose names end with .CHART) 

Open Recent
Shows the recent files menu showing up to 10 recent files - select and Open to re-open 
the chart, or double click on a row. 
At the right of each file is a small trashcan icon. If you click this, you can delete the actual 
file and it will no longer appear in the recent list. But it will also be deleted from your 
computer, so use this option with care! 
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Sample Charts
..this displays the selection of sample charts,  in the same way as Open Recent 

Templates
..offers a selection of preset sizes and apertures for commercially available frames. 

In the list there are preset apertures such as ovals, rectangles, and fancy shapes, which 
are designed to match frames in the Framework (tm) range. 

  

!       

!  

Note: The shapes here are ‘behind’ the grid.  
As you design, if you stay within the white area, you are within the frame. 
You can save any chart as a template and it will appear in this list. 
A chart opened from a template is treated as a new chart and needs a title when saved. 
             

Quick Start
..opens some local web pages with useful information 

Ask Us
..opens a feedback/question form for sending queries to Ursa Software. 

A tick box on this screen will 
send us the ‘debug log’ - (a 
useful tool that can tell us 
where you are having trouble 
in the event of software 

issues… it tells us about crashes, failures to save, the names of the charts you have saved 
, and where you saved them - you would be surprised how often people forget!) 
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The Main Window

The main screen looks like this: 

At the very top of the screen you will see a menu (in the menu area on the Mac, or at the 
top of the design window on the PC) . 
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Toolbars

Main Toolbar
 
Below the menu you will see a toolbar, which consists of a variety of buttons that can be 
used to select from a range of actions.  Some of these actions represent modes of 
drawing, some represent actions.  (Not all buttons are available in all versions of the 
program.) 
All of the buttons represent something that you will also find in the menus. 

The use of these icons is covered in the next few pages in detail. 

Above you can see that the main toolbar could be displayed with icons or shortcuts, and 
can also have descriptions.  
This choice is made in the Preferences menu item. 
The available icons can be amended using the View menu/Customise Toolbar option. 

 
View Toolbar
 
Under the drawing toolbar, lies a series of buttons which can be used to change the way 
the design is viewed. 

When starting out, we recommend the use of the ‘Blocks’ 
view.. it displays in color and is the fastest. 
But you can also work with black symbols, color symbols, 
(plus stitched view, and a range of ‘diamonds’ in the 
premium edition).. just click on the way you like to work 
and the screen will redraw for you. 

Navigator opens a small window with a thumbnail view 
of the chart.. click anywhere on it to jump to that part of 
the design. (See also ‘Viewport’ ) 
Style lets you choose cloth types for stitched view. 
Cloth Color and hpi do what they say.  
Grid lets you set color preferences for the grid’s on screen display.   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Getting Started

Drawing
All drawing is done in the main grid, which is designed to look like a sheet of graph paper 
in the default view. 

 
Every 10th line is shown in a different color, to help you see 
how many stitches you are using.  This can be changed to 
‘every inch’ instead of every 10 squares, in the View menu. 
Also in the View menu, you can change the color of the thin 
and thick lines independently.  Normally they are light grey 
and black.  You can turn off or on the red line that marks the 
middle of the design area (not the middle of the stitched part) 
On the Mac, the thin lines can also be dashed.. there is an 
option in Preferences for that. 

 
Shape: - Cross Stitch designs are based on a square grid, but if you wish to design using 
a rectangular grid for knitting, there is an option for that in the View menu too.  
The grid can be brick shaped.  (Navigation -  View Menu:  Shape/Form : Aran/2 ply/ DK 
etc) or slightly tall , for crochet. 

To change the size of the grid on screen (Zoom), use the control at the bottom right of 
the screen: you can nudge up or down, or select a zoom size from a menu by clicking on 
the number. To change the size of the chart you can click the size shown. 
  

Guidelines: 
 

At the top and right of the grid are rulers showing the size in 
inches/cm, or the row count. 
If you click on the ruler, a pink bar will appear across the 
grid. This is a useful way to line up objects on opposite sides of 
the chart. Click again to turn it off. You can have several guides 
at once.   

Choosing ‘None’  from the View menu, Guide submenu will hide all the lines once more. 
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Stitch Types
Normal full crosses are created using the full cross icon, and erased using the right 
mouse button (or CTRL-left mouse button) 

These icons add several full stitches at a time. 

But there are many other types of stitch you can add to the design: 

These icons draw 3/4 stitches (sometimes called half stitches) in 
the current color. 

These icons allow you to add beads of various sizes, French Knots, and 
buttons.  

Backstitch or outline buttons - To add backstitch, click the leftmost 
of these icons, then click and hold the mouse at one end of the 
backstitch line in the grid. While holding the mouse down, move the 
mouse to a different spot and let go. A line will be drawn in the 

current color. 

The multi-line icon is ‘continuous backstitch’:  - click and hold the mouse, and move 
the mouse around. Backstitch will be drawn in a series of continuous lines following the 
mouse until you let go. 
Next to this is ‘Chain Stitch’ which works in the same way ,but draws a series of links. 

This icon lets you add 1/4 stitches to the design. 

This button appears after you import an image. It allows you to add extra 
detail to the design , by turning full stitches into quarter stitches. (It refers 
back to the original image to find extra details) Drag the mouse over an area 
such as a face to get more detail in the design. 

  

The pencil draws a line of full stitches in much the same way as 
backstitch is added. 
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The Paint Can (Flood fill) lets you fill an area with the current color:   
- Select a color from the palette, click on any solid area of color, and the program will 
change all the touching stitches of the clicked color to the current color.  

You can also fill an area with a motif , or a 
copied selection from the screen (pattern).  
This can be useful for filling an area with a 
chequerboard pattern, or small flower motifs. 
 
Just select and copy an area, then choose 
‘Flood fill with Motif’ from this toolbar icon, 
and click in an area of solid color, or a 
blank area of grid that is surrounded by 
stitches or outlining. 

If you use the on-screen ‘Markup’ feature, 
you might link to use the ‘Flood fill with 
Markup’ option, which marks an area of a 
single color as ‘completed’ 
 

The TT icon allows you to convert letters made from true type fonts into 
stitches: it looks at the black dots where the letters are, and turns each into a 
full stitch. 

 

  
 
The Text button takes you to a new dialog, where you can enter whole words, and select 
from your available fonts. 
Type a size into the Size box. 
The slider control affects the rotation of the text, which can be turned through 360 
degrees. (The preview shows unrotated text until it is pasted) 
The results are turned into a motif, which you can paste, exactly as you would after 
copying an area. 
If you tick the 'petit point' option, the text will be represented using petit point (or quarter 
stitches). This means that you may need to choose a larger text size. 
Note: For multi-line text, please press ‘Enter’ at the end of the row. (the text box on the left will appear to wrap your 
words but you need to have pressed Enter to make an actual new line) 
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BackStitched (and other) Alphabets 
We now offer the creation of BackStitched sentences where you can type 
in words and sentences in one go, choosing from a variety of font styles. 
Most of the ones listed under ‘Style’ are backstitched alphabets. (You can 
create your own alphabets if you like.) 

�

 

Choose a font from the drop down. 
Type your words in the text box. 
Choose a color if you want to change it 
Then click either ‘Paste’ or ‘Paste as Layer’ 

If you choose Paste, then the screen disappears, and you can paste your words where 
you like in the design. 

If you choose Paste as Layer, the pasted words are not ‘fixed’ in place, but can be moved 
around as a layer object, for finer placement. 
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Unusual Stitch Types
In the toolbar is a drop-down menu of unusual (rarely used) 
stitch types. 
These are more commonly found in legacy charts, but are 
presented here to allow you to recreate the special stitches 
they require. 
The Horizontal, Vertical, and Half Stitches are represented in 
the chart as a collection of backstitch lines. 

The 2x2 , 3x2 etc , all the way down to Knitting x 8, are 
stitches which stretch over more than the space of a full cross. 
For example, the 2 x 2 icon gets you a stitch/symbol that is 
twice the size of a full cross. 
The knitting x 2,3,4 etc are the size of a full cross in height, but 
spread over a number of spaces horizontally. These are needed 
for specialist knitting symbol 
designs, and won’t be useful 
for a normal cross stitch 
chart. 

Key inserts a small color 
symbol and the color number 
as text into the chart. 

The remainder of stitches in this menu are a small selection of hardanger shapes , formed 
using backstitch lines. 

Other Toolbar Items
Automatic Outlining  

!  
Use this icon to automatically surround a block of color by backstitch. Select your outline 
color from the palette. Click this icon. Click in a block of color on the design area. The 
outside edge of the shape will be outlined in the new color. 

Automatic Halfstitch  
Use this tool to automatically smooth the edges 
of an existing shape. For instance if you draw a 
round shape to represent an apple, then use 
this option, wherever there is a blocky edge, the 
program will add a half stitch to make the edge 
less severe. 
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Eye Dropper 

!  
Use this tool to select a previously used color from the design, or identify a color from the 
screen.  Click this icon, then position the mouse over a stitch of the color you want to use, 
and click.  (A keyboard shortcut for this is the spacebar.) 
The color you selected will be set as the current drawing color, and shown as such in the 
palette. This feature can also be used to select the color used by a quarter stitch, half 
stitch,special stitches, french knots, or bead. 

Beads 

Choosing this option will allow you to add beads of the current color to the 
design. 
Beads can be placed at any corner of a grid square, at the centre, or at any edge. 
This allows you to place a bead at any of 9 points in a square. 

Like stitches, these can be erased by using CTRL or ALT (or right mouse button on the 
PC). Hold SHIFT to force beads to be laid out in brick pattern. 
 
Beads can either be the beads which are the same size as stitches. Or they can be beads 
of actual , and much larger sizes, such as 6, 8, 10 and 12mm beads.  
These beads will appear differently on different types of cloth. 
For example, a 1/2inch bead will cover 7 squares if you are using 14hpi Aida  
But it will only cover 5 squares if you are using 10 holes per inch tapestry canvas. 

Measure 

This icon works like backstitch, because you click and drag a line from point to 
point. It doesn't add any stitches, but it does tell you the distance from point to 
point if you want to measure an area of stitching in inches or cm 

Select An Area 
 
Use the mouse to surround an area of the chart. 
Once an area has been selected, it will be displayed with a flashing border. 

You can then go to the Edit menu and choose to copy, cut, rotate, or one of a number of 
other actions with the chosen area. 

 
You can delete rows or columns here. 
If you select exactly 1 row or column you will be able to insert a row. 

Areas can be rotated or flipped. 
Areas can be deleted, copied, or moved. 

You can insert a text box, or copyright. 

 - �16



You can save the selected area 
as a Motif, or a speciality 
stitch. (A speciality stitch will 
only use the current color 
when pasted) 
 
As soon as an area is selected, 
the program will display a 
popup menu from which a 
number of area-related actions 
can be chosen without having 
to go to the edit menu first. 

 

If you add a Text box, (this will only appear if the selected area is big enough to accept 
text), you can type a short note which will become part of the chart. 
Or, for a larger area, you can 'Show Chart Comments Here' /Add Copyright Here 
which will display the comments held in the File/Properties menu item. 
'Show Logo in this area' allows you to insert a picture to represent your business. This 
logo image can be set up in the preferences screen. 
You can delete rows and columns. If you have selected a single row or column, you will 
have the option to insert a row or column.  
The area that you select is also copied to the clipboard as a picture , if possible. (there is 
a Preferences item for this) 
 
Lasso Tool 

 
The Lasso tool allows you to select a non-rectangular area. Then you can apply 
the same actions to the selected area as you could with a rectangular area. 
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Shapes 
 
This option has a popup menu that allows you 
choose between ovals, and rectangles, which 
may be hollow or solid, or made up of beads. 
To add one of these shapes, select your option, 
click the main grid, hold the mouse button 
down, drag the mouse to the opposite corner of 
the shape, and let go.  
The shape will be drawn in the area you 
selected. 
There are also triangles and diamond filled 
shapes available here. 

Drag the Design Area 
 
If you select this icon, then instead of drawing when you drag the mouse 
around on the grid, you will move the design around. 
(This is equivalent to moving both of the scrollbars around the grid , at the 
same time. Click on the grid, hold the mouse, then drag the design in your 
chosen direction and release the mouse. 

 
Markup 

 
If you don’t want to print reams of paper or a PDF, and are using a laptop or 
tablet machine, you might choose to stitch ‘from the screen’
If so, you can use the Markup option to ‘tick off’ each stitched square.
Click on this icon and click or drag the mouse over the design.

Ticks will be added where you 
click, to indicate which parts you 

have stitched.  
Note: the markup isn’t part of the design, and 
won’t appear on printouts.

The color of the tick image can be set in the 
Markup menu. 
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The Palette.

Every chart can have its own selection of colors. 
They don’t all have to be DMC, or Anchor, and they don’t even have to exist: you can 
invent your own. 
There is space for up to 254 colors in any chart, and these can be chosen from our 
shipped selection of manufacturers. They appear on the left of the screen in your Palette 
of colors. 

As you work, the number of stitches next to each color is updated.
Next to that is a small blob of what we call the ‘alternate color’.. this allows you to set a 
different color for printing, (where a pale yellow or white might not show up , you could 
assign a blue and print with that for clarity)

Control-click (or right-clicking on the PC) on any of these 
colors will produce a popup menu with additional options, 
such as removing, flashing, highlighting, blending, or 
replacing them in the chart. 

Between the palette and the grid is a bar which you can 
drag to change the width of the palette. This allows you 
to see the numbers and names of the threads. 

At the bottom of the list of colors are these 3 buttons.

The first (+) is the ‘Add a Thread’ button. 
The second (the palette) allows you to choose a color from a color swatch instead of by 
name or number. 
The last in the list switches the palette away and replaces it with a thumbnail view of the 
current design. 

To draw using any of the colors, click on the color in the palette and then begin clicking 
or drawing in the main grid.
The eraser at the top-most edge represents the cloth , or ‘eraser’ option. Choosing this 
option will place you in ‘erase mode’, where using the mouse will erase stitches instead of 
adding them, (as if you were drawing with cloth). 
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Add a Thread

You can select a range of threads from the Thread Family drop down menu. 
The list will refill with the full range of threads. 

On the right is the current palette arranged as a grid. 
To add one or more colors, select them in the list using the mouse. (You can use SHIFT to 
select more than one), then click the green arrow to add to the palette. 
The eraser will undo any that you add. 

If you type a word or number into the 'find' box, the list will show items containing the 
text you type.  
You can choose a range by selecting a range from the combo box labelled ‘Thread Family’  
Other options include DMC, Madeira, wools, and more. 
(Many more thread families can be obtained from our friends at www.myriacross.com,  or 
using the menu item under the ‘Help’ menu in the app.) 

Click ‘Save’ to make the palette changes permanent. 
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Motifs, Alphabets, and Special Stitches.
At the bottom of the palette is a control panel that switches the palette out to show other 
items. The clipboard icon usually has a small note to show how many recent items have 
been copied. 
The Motifs row has a small checkbox which is used to govern whether you are pasting 
several copies of a motif (ticked) , or just one (unticked ..pastes then switches back to full 
stitches mode) 

(To switch between these views, click on the name of the view you want) 

Motifs
Motifs are small sections of design, saved for re-use later. 
You can create a motif by selecting an area of a chart, and 
choosing ‘ Save this Area as a Motif’ from the Edit menu, or 
the popup menu that appears after you select. 
Motifs live in the Documents/MacStitch/Motifs folder, and can 
be arranged in folders. The folders are shown here as grey 
bars, and can be opened to reveal the contents. 
To use a Motif, simply click the one you want, and the 
program will load it into its internal clipboard, and put you 
into ‘paste’ mode: the shape you chose will be floating under 
the control of the mouse. Move the mouse to the place where 
you want to paste the motif, and click. 
You might want to repeat the motif, so a preferences setting 
allows you to choose between a single paste action and 
repeated pasting. (Stop on first click…), but the checkbox 
next to ‘Motifs’ has the same effect. 
To repaste, press CMD-V (mac) or CTRL-V (win) 
To stop pasting , press escape or click the full cross icon. 
To paste a motif as a new layer, click the motif then press 
CMD-L (mac)  or CTRL-L (win) 
To paste a motif using the current color only, click the 
motif then press CMD-J (mac)  or CTRL-J (win) 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Alphabets
Alphabets are named motifs, saved for re-use later. 
Alphabets live in the Documents/MacStitch/Alphabets 
folder, and are arranged in folders. 
They are used exactly like motifs. 

You can create an alphabet set by choosing File/New 
Alphabet from the File menu. 
An alphabet is a set of up to 72 motifs, which you can 
create in a special grid for the purpose. 
When you select the New Alphabet menu option, you 
need to decide how big the individual letters will be. 
 

!  

 

Here, we chose a 10 x 10 area for the letters. 
A new design window appears, with the normal 
grid overlaid by an extra grid showing where each 
letter should be created. 

Draw an A in the A box, and repeat for any other 
letters you want to define. Keep each letter inside 
the guidelines. 
Best leave one column empty at the left if you want 
to create a set of BackStitch Letters (see 
BackStitched Alphabets, below) 
 
You do not have to create all the possible letters. 
When you are finished, click SAVE and the alphabet will be saved in two forms: a .chart 
file , and a set of motifs. 
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Backstitched Alphabets
When you Save a set of letters you design, you will be asked if you want to use them as a 
BackStitched Alphabet. If you say yes, the letters will be available here. There are 6 or 7 
sets shipped with the app. 

If you want to save individual motifs there, or copy an existing alphabet, you need to copy 
and create a few files manually. 
In the Documents/MacStitch or My Documents/MacStitch folders. (WinStitch on the PC), 
you will find a folder called Alphabets 
 

In there, there will be a batch of files and folders with the name you gave to your 
alphabet. 

In this example, ‘myletters’ 
Copy all 3, and paste them into the folder ‘bsalphabets’ 
 
They will then appear as options in the 
Backstitched and other Alphabets toolbar 
option.  The JPG file is the small preview that 
is shown in the list of alphabet names.

But normally you create and save a ‘New Alphabet’, and the app will ask if you want to 
promote it to a backstitched alphabet too. 
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Special Stitches
Special Stitches are named motifs, saved for re-use later. 
Alphabets live in the Documents/MacStitch/Speciality folder, and 
are be arranged in folders. 

They are used exactly like motifs, but with one key difference: 
they have no color of their own. 
When pasted, all the stitches will be pasted in the color currently 
selected in the palette. 

This allows you to use backstitch shapes (for hardanger work) in 
any color you wish. 

To create a speciality stitch of your own, draw a shape in the 
grid, then select it using the Selection icon from the toolbar. 
Once selected, choose ‘Save this area as a Speciality Stitch’ from 
the edit menu or the popup menu that appears after the 
selection. 
Like motifs, a special stitch can be pasted using CMD-V 
And used as a Layer by pressing CMD-L after clicking the item. 
(CTRL on the PC) 

Clipboards
Clipboards are unnamed but dated/timed motifs, saved for re-use later.  
Clipboards live in the Documents/MacStitch/Clipboards folder, and have a limited lifespan. 

A saved clipboard is created every time you 
select and area and choose ‘Copy’ from the 
menus. 

During a day / session, the things you have 
copied will be stored here, and you can go back 
to them at any time to re-use them. 

(Each time the program starts, old clipboards are 
removed: so if there is one you wish to keep, 
remember to copy it from Clipboards to Motifs 
folder at the end of the day) 

nb: If clicking on ‘Clipboards’ becomes 
unresponsive, it could well be that the app has 
not been able to delete old motifs and is taking a long time to read them. 
You can manually throw away old ones by looking in Documents/MacStitch/Clipboards 
folder   (Documents/WinStitch/Clipboards ) and deleting the contents. 
Or Control-click on the ‘Clipboards’ word which does the same thing. 
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Layers (movable motifs)
The final item at the control panel below the Palette is ‘Layers’. (Premium edition) 
Layers are a powerful feature that allow you paste items into the chart without making 
the change permanent. 
A layer can be : 
• moved after placing 
• hidden 
• flattened into the chart permanently 
• deleted without affecting the original design 
• formed of stitches 
• formed of an image, such as a photo 
• used as an ‘Onion Skin’ image, behind the grid 
• a small key to symbols 
• Made transparent 

(If you are familiar with layers in art packages such as Illustrator where each layer can be drawn upon independantly, 
please note these motifs are not the same kind of thing) 

Layers have an order of 
importance. 

The ones at the top of the list 
appear on top of other motifs, 
and most layers appear on top of 
the chart. 

You can change the priority of 
the layers by dragging the whole 
row up or down the list. 
 

To delete a layer, click the trashcan icon. 

To temporarily hide a layer, click the eye. An eye with a red cross indicates a hidden 
layer. 

To make a layer become part of the design permanently, click the flatten icon- after 
that it stops being a movable layer. 
To make a layer transparent, click this icon, and choose a level of transparency, from 
‘none’ to 20% 

Image layers cannot be flattened, and show a camera icon. 

Onion skin images are never printed, and show a grid icon. 
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Using Layers
You insert a copied area as a new layer using CMD-L, or using the options in the Insert 
menu to insert pictures. 
To move a layer about, you start by clicking the Layers option in the control panel at the 
bottom left, so that you can see all layers listed. 

Click on any of the rows to select a layer, and it will be surrounded by a green rectangle. 

To move the selected layer, click within the green rectangle and drag the mouse 
around. 

In the screenshot above, there are ‘real’ 
stitches, stitch layers, an ‘Onion Skin’ 
layer, and a photo image. 

You can drag a stitch layer when it is 
selected.  
Clicking on another layer will select the 
second layer. 

When the selected image is an onion 
skin layer, or a photo layer, the selection 
rectangle will also have ‘resize handles’. 
Dragging the red resize handles will 
resize the image on screen. 
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Unless a layer is hidden, it will be printed or exported into a PDF as if it were part of the 
chart. 
Stitches used by the layer are not ‘counted’ as part of the chart until merged, or printed. 

During printing, the layers are temporarily merged in order of priority. 
The lower layers are merged first, then the upper layers. 
If layers overlap, this means that some stitches from lower layers will be replaced by 
stitches from the upper layers. 

If your chart includes layers, they will be preserved when you save and load the chart. 
(However, this new functionality means that charts with layers are no longer readable by 
older versions of MacStitch and WinStitch) 

The Status Bar

Along the bottom of the main window is a status bar, showing information about the chart 
and selected thread. 

The panel at the left shows the current color. 

Next to that is the symbol used by the current thread. you can click on that to change 
the symbol. 

A checkbox marked ‘Mirror’ lets you start drawing in ‘mirror mode’.. (all stitches on the left 
of the screen are repeated on the right, like a Rorschach inkblot test). 

In the centre of this bar is the current thread name. Click here to edit the thread. 

At the far right hand side, the zoom control. 
Click on the percentage to choose a new zoom size, or use the up/down arrows 
( + and - keys on the keyboard should do the same thing) 
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Edit the Current Thread

On this dialog, you can change the name, number and comments for the current thread, 
just type over the values. 
What you type here only affects the current chart. 

You can change the number of strands. This affects 
the thread estimated usage, and the thickness of 
backstitches displayed on screen. 
Clicking the symbol will allow you to choose a 
different symbol. 
The last symbol in the list (a blank space after the 
letter Y) has a ‘special’ meaning.. when used, you get 
no symbol on the printout, and the grid squares do 
not print either: so you can use this to make ‘cutout’ 
areas of grid for hardanger purposes. 

Color is the ‘normal’ color of this thread, where 
‘Alternate Color’ is used to highlight a color on printout, or make a light color darker so 
that a color printout can be seen. (Se printing) 

The Dash Line Pattern is used to set how backstitches will appear in Advanced PDF 
export for threads of this color. 
You can set the ratio of black to white (color vs gap), by changing the On/Off values. 
Start with 3 and 3 then change the values for other threads if you wish. 
When ‘Off’ is zero, you always get a solid line. 
On Mac only , this dash pattern is also shown on screen and printer. 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The File Menu: (Load & Save Charts, Print, Simple PDF…)

The file menu contains options for opening existing charts, creating new charts of various 
types, printing, and the option to close a window. 

Launch Wizard: this opens the same dialog you see when you start the program, giving 
access to recent & sample charts etc. 

Open a Chart
Open.. this opens a standard file browser for you to look for existing charts or motif files. 
(Charts are normally saved in ‘Documents’, or ‘Your Charts Here’ folders but you can save 
charts anywhere, including onto USB drives.) 

Open Recent.. 
This displays a list of recently accessed charts, with a small thumbnail view if available. 
Click on one to open it. 

!  
AutoSaves… 
As you work, if you have ‘Autosave’ turned on, the app will create a saved version of your 
chart every 10 minutes or so. This menu item lets you go back to one of those if you need 
to. 
Sample Charts… 
This opens the file browser, in the sample charts folder. This is the same set of sample 
charts as presented in the Launch Window 

New Charts
New.. this opens the ‘new chart’ dialog. (See the launch window section for an 
explanation of this screen) 
New Border… 
Using the new border option, you can create new 
borders of your own design- you design the corners 
and edges of a pattern. 
This dialog lets you say how large the components 
are. 
In the example shown, all the parts are 20 stitches 
wide or high. When you use a border designed this 
way, the corners of the design are the corner areas of 
the border. 
The middle sections are repeated many times to fill 
up the space. The boundaries of these areas are 
shown using blue lines when you are editing the 
border in the main window. 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New Knitting Layout… 
For knitters, a set of common symbols has been developed to represent different stitch 
types.  
(This is different from the concept of using a symbol to 
mean a color in cross stitching.) 
 
If you choose to start a new knit layout, the palette will 
contain a set of symbols which relate to stitch types, 
and all the 'colors' are black. (But can be changed)  
 
The palette looks like the image shown here: 
 
When designing in knit layouts, not all of the toolbar 
items are visible. (For instance half and quarter stitches 
make no sense and will be unavailable) 
For stitches such as 2/1 RPC S1 to cn, hold to back, the 
symbol is expected to occupy more than one stitch space horizontally. 
This is done by using the 3 x2 , 4 x 2  etc stitch types in the hardanger menu. 

New Alphabet… 
(See ‘Alphabets’ in the palette section) 

New Plastic / Tapestry… 

Choosing this option switches the stitched view to be Tent Stitch style. 
In this kind of chart, a tent stitch can be either /  or  \ 
The direction used is set on a ‘by color’ basis (see ‘Edit Thread’) , so if you need red 
stitches in both directions, you need to add red to the 
palette twice. 

Choosing the New Tapestry/Plastic option will open a 
modified version of the New dialog, which offers different 
settings. 
 
Because plastic canvas is often used to make solid shapes 
which are effectively cut out of the material, the New 
Plastic dialog offers you a selection of shapes to work 
within.  
These shapes are stored as simple black and white images, 
and can be found in the Documents/macstitch/shapes folder. 
(My Documents/winstitch/shapes on Windows machines) 
 
You can create and add your own shapes if you wish.. just create a black and white PNG 
file of about 100 x 100 pixels, and drop it into this folder. 
If you select one of these shapes, when your new design opens, the black area will be 
canvas, and the ‘remainder’ will be ‘desk’.  
In this screenshot, the canvas is white (this can be changed in the view menu / cloth 
color).  
The background (desk? ) is a blue texture. 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The texture used for the default background is 
held in a file called ‘background.png’ in the 
macstitch or winstitch folder mentioned above. 
 
We supplied a few alternatives, which you can 
find in the ‘backgrounds’ folder.  
Replace ‘background.png’ by one of the others if 
you want to change the style  
 
See ‘Working with plastic’ for extra information 
relating to plastic charts. 

Properties… 

Each chart has a few properties that can be set here. 
They are:  

Title  (this does not have to be the same as the 
filename) 
Comments (a space for notes about the design) 
Copyright (Your copyright notice) 
Your ‘normal’ copyright notice can be entered in the 
Preferences dialog. 
It will be copied into each new chart you create. 
But you can vary it on a by-chart basis, in this dialog. 

This copyright notice is the one you can insert into a 
chart using the ‘Insert Copyright here’ option in the 
popup which appears after you select an area. 
It is also used for page footers when printing. 
Similarly, the comments here are this that appear in 
the ‘Insert Comment Box here’ popup. 

The size of the design , and stitch counts are shown 
at the bottom of this window, for information. 

Save/ Save As…

Save As allows you to save your design where you wish with a chosen name. 
The normal save location is Documents/MacStitch/Your charts here  or  
My Documents/WinStitch/Your charts here 
However, you can save elsewhere if you wish, including to USB drives. 
When you save, a small JPG file is saved as a thumbnail view. Do not mistake that for the 
chart if using a browser when looking in the folder. 
Your file name should end with .CHART 
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If the name you enter does not end with.CHART, the program will attempt to add .chart to 
the end.. (without the extension your computer may not know what to do with the file if 
you just double click it later.) 

The file format used by our software has changed little over the years, but the 
introduction of Layers and Markup has meant we recently needed to create a new way 
to save files. 
The software will save in ‘the old format’ if you don't have layers or markup, and in the 
‘new’ if you do have layers. 
You should see no difference in loading or saving, but new format files cannot be opened 
by older versions of the software than the 2016 edition. 

Every time you save a design, we also zip up a copy of it into a file in your 
Documents or My Documents folder.  (a preferences setting) 
If you make a drastic mistake after a week or two of work, or forget where you saved, 
older versions of the chart are still recoverable later unless these zip files are deleted. 
(To access old versions, use the ‘recover file from Archive’ menu item) 

Cross Stitch 2 Go… 

Cross Stitch 2 Go was our iPad app.  
It’s very much simpler than the desktop program, but is a handy way to create motifs and 
small designs on the move, and is also a neat way to stitch your work, using the iPad 
screen instead of sheets of paper. 
If you want to save your work for Cross Stitch 2 Go, it must be  
200 x 200 stitches or smaller with no more than 40 colors. 
Also, because the backstitch method is simpler, you won’t keep point to point backstitch, 
beads, buttons or knots. 
Like saving an ordinary chart, you will be presented with a standard File Save dialog, with 
which you can save the design. Cross Stitch 2 Go designs have names which end with .cht  
So save your design with a name ending in .CHT and the program will know you intend to 
export to Cross Stitch 2 Go. 

Page Setup… 

This option displays the program’s print settings dialog, and the printer’s page setup 
dialog. Here you can set the properties of your chosen printer. 
 
Thread Sorter… 
 
The thread sorter option creates a series of pages listing 
the colors from your current chart. 
Print this to sheets of cardboard, and punch holes next to 
the thread names, for use as a thread sorter. The rows of 
thread colors will be 1/2 inch apart as this is a common 
size for plastic pre-formed sorters. So it should be easy to 
cut out the strips and glue them to the plastic if need be. 
You can select between 2,3,4 and 5 columns per sheet. 

The output looks like this: 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The File Menu: Print/Print Selection/Print as PDF
Choose Print from the file menu.  
Your default printer, page size etc, will be assumed. 
If you chose the ‘print selection’ option, then only the selected area will be printed. 
The following dialog will be displayed: 
 

On the settings page, there are 
many choices that can affect the 
printout. 
The program already knows what 
size paper you printer is using, and 
will arrange the output in a shape 
to match that. 

Style 
You can print your design in the same styles as you can view it while editing: 
Black Symbol, Color Symbol, Symbol on color, etc. Extra choices are available in Premium. 
Choose the printing style from the drop down menu at the top. 

Alternate Colors 
Each thread in the palette has a ‘real’ color and an alternate color. You can change these 
by clicking the thread name at the bottom of the design grid. The alternate color can be 
used to assign a darker shade to light colors so that they print clearer in color symbol 
view. Or you might set all the alternates to grey or white, apart from one, and so get a 
chart that shows one color strongly in isolation. 
Ticking this box makes the printout use the alternate color instead of the ‘real’ color. 

Symbol Size  (symbols across the page) 
The bigger the symbols / color blocks on the paper, the less of your design will fit on one 
page. A magazine typically prints designs at around 55..70 symbols/squares across a page 
of A4 in portrait mode. 
In the screenshot above, the setting is 71 across the page, and you can see that for this 
design it will can fit the whole chart on one page. 
Less per page = more pages. 
Higher number = less pages but harder to read. 
Also, if you are creating a printout for ‘Diamonds’, you can see it shows (1/10) in 
brackets .. this is the most common diamond size. 
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Margin 
The space on the page is affected by the margin setting. The higher the number, the 
bigger the gap between the edge of the page and the start of the grid. 

Print with an Overlap 
If your chart occupies more than one page, you can make the pages repeat up to 5 of the 
stitches from adjoining pages using this setting. Duplicated stitches will appear under a 
shade area in the printout. 
Print Centre Marks 
This option marks the horizontal and vertical centres of the design 
with an arrow on the printout. 
Row/Column 
When this is ticked, the rows and columns will be numbered. (If 
Bottom to Top is ticked, the numbers start at the bottom and work 
upwards: handy for knitting and crochet) 
Grid 
When ticked, there will be a grid. Unticked, none. 
Thick/Thin Line Widths 
These options set the relative thickness of the thick and thin lines of grid. 
Title 
This will contain the chart title if you have set one. If ticked, it will appear at the top of 
each page. 
Copyright 
This will contain the copyright if you have set one. If ticked, the copyright will appear at 
the bottom of each page. 
Page No 
If ticked, each page will have a number at the bottom. 
Print Key 
If ticked, a key to the colors and symbols will be added as the last page/s. The estimated 
length column of the key can be either a length in cm/inches, or a stitch count, or an 
estimate of the number of 8mtr skeins. 
Page Map 
If ticked, a page showing 
thumbnail views of each page 
and the numbers will be added 
to the printout. 
Only export the used area 
If your chart has a lot of white 
space, you could remove it 
before you print, but ticking this 
box will ensure that only the 
used area is printed, not the 
white unused area. 
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Print 
The print button sends the output to your printer. 

Print Quality: 
Your choice of paper has a big effect on the printed results, especially if you are using 
colour ink jets. 
You can see from the screen that there are thick and thin lines, and you can see all the 
detail. However, if you print on absorbent paper , in color mode, it can happen that the 
inks will bleed into each other and the detail is lost. 
Printing an A4 image on letter paper can distort the shapes too. 
Below is a real-life example of using incorrect paper and print quality settings. 
The printer produced the output on the left, although what was sent is on the right. 
 

!     should be      !  
 
To avoid this loss of detail, use proper coated inkjet paper, and set your printer to print in 
photographic mode, (where it uses several light passes of ink which it allows to dry a little 
before over spraying). 
 
Print preview 
Here you can see the pages 
before you actually print. 
Full Size zooms in for better 
detail. 
The small printer icon prints 
just the page you can see. 
The small arrows and the 
p1/7 area are where you 
switch to another page. 
Export (PNG or PDF) 
The export button allows you 
to save what would have been 
printed, as a series of PNG 
files in a folder, or as a PDF 
file. 
A PDF that is generated here 
can be emailed or printed, and are fine to use for selling charts online. 

But the symbols it contains are not selectable or highlightable in a PDF viewer or editor. 
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To get that kind of PDF , you need to use the Advanced PDF export in the Premium 
edition. (It also now uses scalable fonts to give a much higher resolution / sharpness to 
the output.) 
Diamond Painting 
Diamond painting is a technique that resembles cross stitch, but involves placing plastic 
beads/ squares/ diamonds onto a fabric area or even tough paper. 
The diamonds are usually available in DMC shades, and are usually 1/10 inch in size. 

To produce a chart that such beads can be glued to , some people will print onto canvas. 
(The printing material needs to be a special type of fabric, coated to prevent ink from 
bleeding) 

If you want to print for this purpose, you must ensure that the symbols are printed at 
1/10 inch or slightly bigger. 

So on the print dialog, when you adjust the number of ‘Symbols across the page’, when 
the resulting size reaches roughly 1/20 inch , the screen will show 1/10 inch as the size , 
even if you chose to work in metric measures. 

At 1/10 inch, you can expect to get about 50 to 60 symbols across a sheet of A4 paper, 
and perhaps 70 down. 
A chart with more symbols than that will need several sheets of paper/fabric, or perhaps 
material of A3 or A2 if your printer can accommodate it. 

The preview option can display as diamonds, but the main chart from which you work will 
most likely need to be symbolic, or symbols on color - (trying to tell apart two similar 
green or red colors is difficult from a printout) 
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The Edit Menu: (Copy, Paste and Area Functions)
The edit menu, as in most applications, offers 
Cut / Paste / Copy / Erase / Select All 
and these work as you would expect them to, on areas of chart that you select using the 
select tool. 

(tip: Most of the Edit menu functions are also available in the popup menu that appears 
immediately after you select an area. Some only appear on that menu) 
Undo 
The application records your actions as you go along. If you make a mistake, you can 
undo many times until you get back to a point you like. You can also have autosave 
turned on, and make regular saves of your own if you wish. 
Redo 
When you undo, the current state is saved. So if you Undo by mistake, you can get back 
the current chart with this option. 

Paste 
Use this option to paste a previously copied or cut area into the design window as part of 
the chart. Once this has been clicked, an outline of the item to be pasted a motif will 
move around under the control of the mouse. Click when the motif is positioned where 
you want it. 
There is an option in the preferences dialog to determine whether the pasting should 
continue, or whether the pasting should stop and revert to full stitches mode. 
 
It is possible to place the pasted motif half-way between stitches, so that quarter stitches 
in the left corner can be pasted in the right corner. 
To make this possible, press the SHIFT button while you move the shape around with the 
mouse. “Normal” stitches will be converted to special stitches if required when you paste. 
you may also : 
Paste as New Layer (See ‘layers’ for more detail) using CMD-L or CTRL-L 

A selected area can also be flipped or rotated using one of the Flip or Rotate menu items. 
After flipping or rotating, you will be able to paste the selection in the normal way, or 
paste it as a new layer by pressing CMD-L or CTRL-L 

With an area selected, you can 
Erase… 
You can select an area and erase all backstitch or French Knots/Beads/Special stitches 
using the Erase… option 
Crop to this Area.. almost the opposite of ‘erase’, this option discards everything apart 
from the area you selected, leaving the selected area as the entire chart. 
Save Selected Area as Motif , and 
Save Selected Area as a Speciality Stitch. 
(see.. ‘Motifs, Alphabets, and Special Stitches’) 
Motifs are small pieces of design saved in color, in the Motifs folder, while Speciality 
Stitches are small pieces of design saved in a way that will take on the current color when 
pasted, and they are saved in the ‘Speciality Stitches’ sub folder. 
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Change Design Area 
This option allows you to change the size of the cloth on which you are designing. You 
can increase or decrease the size using the same selector as you use when starting a new 
design. 
When resizing, you will be asked if you want to resize the design also. 
If you answer yes, then the design will gain or lose stitches to make it suit the new cloth 
size: so reducing the area and resizing will make the number of stitches and the finished 
work smaller. 
If you answer ‘No’ then the cloth size will be changed, but the design will be left alone. 
This may mean that parts of a large design are lost when you reduce the cloth size, if the 
new size is smaller than the stitched area. 
Resize The Design 

 
This option lets you change the size 
of the design. 
Drag the slider left or right to see 
the effect of the change. 
French knots and backstitches are 
positioned using non-white number 
positioning, and so may not line up 
with grid lines after being resized. 
So we don't usually include them 
during the reszing, but you can 
leave them in if you wish. If the 
results are not to your liking, UNDO 
will take the chart back to the 
original condition. 

Auto Centre 
As you design, your stitched area may not lie in the centre of the cloth. 
Using auto centre, you can automatically move the stitched area to the middle of the cloth 
area, leaving an even amount of blank cloth around the edges. 
You may find it useful to increase the design area before using this option. 
Rotate Design 90 Degrees 
The chart is turned clockwise by 90 degrees. 
Move to Top Left 
Almost the opposite of Auto Centre, this option shifts your stitched work to the left and 
top of the cloth area, leaving all the blank cloth at the right and bottom. 
This would normally be done before reducing the cloth area in size if you wanted to avoid 
losing part of the design. 

Crop to Fit Image 
This option removes the unused cloth around your design.. rather like selecting the used 
area by hand and using ‘Crop to this Area’ 
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Insert ??? Columns 
Insert ??? Rows 
If an area is selected, you can use these menu items to either delete one or more whole 
rows or columns of stitches, 
or  
Insert blank rows or columns. 
This allows you to pad out the space between motifs, for example, or to remove some 
unwanted white space. 
 
4-Way Symmetry 
A handy way of creating symmetrical patterns. You design only one quarter of the area, 
then use this option to reproduce the top left corner of the design area in the other 3 
corners. Depending upon whether the chart has an even or odd number of stitches, the 
number of rows or columns empty or duplicated in the centre will vary. See also: ‘Mirror 
mode’, which is turned on using a checkbox at the bottom of the window: this repeats 
your stitches left and right as you draw. 
Adjust size for Knitting  
Knitting stitches are flatter than cross stitches. 
If you knit a cross stitch chart, it will make circles look like flat 
ovals, for instance. 
This option avoids that problem by adding duplicate rows to 
the design, making it look taller on screen. 
When knitted, however, the final shape will be correct. 
So, if you have drawn a circle on screen and use this option, 
your circle will gain rows and become a tall oval. When 
knitted, the tall oval will be flattened into a circular shape of 
knitting. 
A dialog will ask you for your knitting tension, expressed as 
the number of stitches across and down a knitted square. Typically, for every 10 knitted 
stitches across, you will knit 16 stitches down ― a ratio of 1:1.6 
Because the software supports rectangular grids, you may wish to use this option to take 
a normal cross stitch design and stretch it before switching to rectangular view to 
continue working on it. 
Despeckle attempts to remove odd stitches of color from an area which is otherwise 
solid 
 
Start Dictation 
Start Dictation / Emoji and Symbols 
These two menu items are inserted into the menu on Mac machines by the operating 
system, and are not ‘part’ of MacStitch. 
We do not recommend inserting emoji into text areas, however - in testing we found that 
they should print when used in text areas, but they will not work in the Advanced PDF 
Export option. 
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The Insert Menu

Insert a Picture  (See Layers) 
Insert a Picture behind Grid 
Both of these options allow you to browse for a picture from your computer and insert it 
as a new layer into the design. Images inserted in this way do not get converted into 
stitches.  They can be resized when selected. 
A picture ‘behind the grid’ can be drawn over: stitches will hide it.. it is a miniature , 
placeable onion skin image. 
Insert a Picture from Clipboard 
Insert a Picture behind Grid from Clipboard 
These work as the options above, but are only enabled when 
the program can detect an image is in the clipboard. 
Insert Key 
Using this option you can insert a small key to the colors into 
the design. The inserted key is an image, and is resizable 
and movable. 
Insert row/column 
This increases the chart size a little, and moves your design 
one space down or right, if need be. 

The View Menu

Hide Toolbars 

To get more design space, you can now hide the Toolbars by ticking this item, and reduce 
the palette to a narrow strip, using the View menu/Hide Toolbar option.  
(All of the items on the toolbar can still be found in menu items, and to change color you 
click on the small color area at the bottom left corner) 

Customise Toolbar 
The lesser used buttons from the toolbar can be hidden or re-arranged using this menu 
item, 
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Stitch Size 
Here you can set or change the number of crosses you intend to stitch pr inch. (Or 
equivalent in metric) 

Grid Shape/Ratio: 
Normally cross stitch patterns use a square grid. But if you are designing Swiss Darning or 
Crochet work, you may want a non-square grid to work on. Here you can choose from a 
range of pre-defined ratios such as Aran & DK for knits, or 9:5 for crochet. If our ratios 
don’t match the one you want, select ???/??? and define your own 
f you are working or view in stitches mode, the stitches will change to resemble stocking 
stitches. 

Style: 
Allows you to set the style of cloth you will work on. You can choose between aida, 
lynda , evenweave and other cloth types. And you can choose whether your crosses 
should be worked ‘over 1’ or ‘over 2‘ holes.  
Cloth Color: 
Allows you to change the color of the cloth. The chosen cloth style will be colorised to 
suit. 
Zoom: 
Changes the size of the grid on screen. 
Thin/Thick Grid Color: 
Changes the color of the grid lines on screen. 
Grid Visible: 
Turns the grid on or off on screen. 
Backstitch Visible: 
Hides backstitch on screen.. this can speed up the program if there is a lot of backstitch. 

Backstitch List / Locator 
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Sometimes you can create some backstitch by accident, and struggle to find it, especially 
if it is just a dot on screen. Stray stitches can prevent you from cropping to the used area, 
for example. 

The BackStitch List simply shows a 
list of all backstitches (could be a 
long list!), the color, and position. 

If you want to see a particular 
stitch, click on any row: the 
screen with shift to display the 
stitch, and two red circles will 
show the start and end points. 
If you want to delete one or 
more, just tick the delete box, 
and click Delete. 
If you want to change the 
color, tick one or more, select a 
new color on the right, and click ‘Replace’ 

(There is a similar dialog for beads and knots) 

Thick Lines Every: 
Sets the thick lines every 10 stitches, or every inch 
Guide: 
You can set guidelines up to divide the display into 3x3, 4x4, or 5x5 areas, if you need 
help lining up motifs or text. 
Rulers Show: 
Allows you to choose between inches or stitch count on screen. 
Thumbnail View: 
Displays a small view of the design. You can click anywhere on the picture to jump to that 
part of the design. 

Viewport: 
The Viewport option opens a new window, which is a ‘view’ of the existing chart. 
But in the viewport you can view in a different style, and have a different zoom size. 
This allows you to work on fine detail in a ‘magnified’ fashion, and see the effect ‘zoomed’ 
out in another window. 
The viewport could even be dragged to another screen if you have a dual screen system. 
In the screenshot above, the main window shows the design zoomed out, and in ‘symbols 
on color’ mode. 
The viewport (right) shows the same design but at a bigger size, and in color blocks. 
You can select colors and drawing style on the main window. 
And you can draw stitches in either of the windows: (the window you are not drawing on 
will ‘catch up’ a second or two after you release the mouse when drawing.) 
To change zoom size or display mode on the Viewport use the icons at the top of the 
window. 
If you close a window that has an open viewport, the viewport will close too. Closing the 
viewport window leaves the original open. 
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Framed View: 
 
This feature allows you to see the 'finished design' in a view that places borders and 
picture frames around it, to help you visualise how the framed work will appear. 
 
You can experiment with the Frame styles, mount colors, and sizes.  Mounts can be 
rectangular or oval. 
In the Frame section of the sidebar, click on the style option, and you can choose from 
approximately 14 styles of frame, including a variety of wood and metal styles. 
The ‘Size’ scrollbar below that lets you change the frame width. 
!  Switches between rectangular and oval mounts. 
!  This button allows you to tint the frame or the borders. You can have up to 2 borders 
within the frame.  
Click on the color in the style section to change the border colors, and use the scroll bar 
to change the widths. 
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It is possible to create your own frames:  
Look in the Documents/MacStitch/Frames folder on your machine. (My Documents/
Winstitch/Frames for windows machines) 
Each frame has its own folder. 
In the folder is a file called whole.png plus a partner one called whole_mask.png 
The ‘whole’ files are used to provide round or shaped frames. 
The whole.png file has the main picture.  The whole_mask.png is a black and white 
image, where the black area = parts you want to see, and white area = transparent. 

Onion Skin
Onion Skin allows you to place a picture or photograph as 
the background (behind the grid) of your work area. 
 
It does not convert the image to a chart  
(See : Importing an Image) 
Instead, it allows you to draw stitches and lines over an 
image, by hand. 
When you are finished drawing, you remove the background 
by selecting ‘Cancel’ and only your work remains. 
You can do the same kind of thing using a ‘Layer’, and 
placing an image behind the grid. Onion Skin occupies the 
whole design area. 

A photograph imported as an Onion Skin image, with some drawing already over the 
castle area… 
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and the castle 
after the onion 
skin image is 
cancelled, 
leaving only 
stitches behind. 

 

Of 
course, 

the chance that an image behind the grid will 
match the existing squares exactly is quite 
small. 
You may need to nudge the image left, right, 
up or down. 
It may need to be slightly rotated,  made 
bigger or smaller. 
You can do that using the View/Onion 
Skin/Adjust  menu option. 
Using the controls shown here, you can tweak 
the placement of the onion skin image in real time, watching how the changes affect the 
lineup on the grid. 

Slight clockwise rotation applied here to make 
vertical lines match the grid.  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The Palette Menu

Each chart can be composed of up to 255 colors.  
The colors can be chosen from a variety of manufacturers’ ranges, each of which can have 
many more than those 255 shades from which to choose. 
The palette menu contains options for changing the palette of threads you are using in a 
particular design.  
It does not affect the manufacturer’s supplied list of threads 
 
Note: Many of these menu options are also displayed if you right-click or control-click on 
any color in the palette. 
 
Some of these options are described in ‘Palette’ section earlier in this document. 

Add a Thread 
Edit (This thread) 
Can be used to add one or more threads to your current palette. 
Discussed in the ‘Palette’ section earlier in this document. 

Alternate Symbol Color... 
     Make All Alternate Colors be White /Grey/Original 
 
As you have seen from the Edit Current Thread option, each thread actually has two 
possible colors.  
The second is used when printing color symbols, and is normally used to make pale colors 
easier to see on paper, by printing in a different color,  

Some customers requested a way to print ONLY one or two of the colors from a design at 
a time. You can do this by manipulating the alternate colors.  
For example, to print ONLY the red stitches, use ‘Make All Alternate Colors be White’. Then 
Make the alternate color for the red stitches be some other color , or black. Print the chart 
in color symbol view, and only the red stitches will appear on paper. 
 
You can use the ‘Reset to Original Thread Color’ to set things back to normal. 

Font Size 
You can change the size of the rows of data in the palette, to allow more colors to be 
seen at once. 

! !  

Default Settings will reset the palette to the original size. 
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Flash Stitches of the Active Color 
This switches to a view where the active color is shown in bold, while the other colors are 
pale. It doesn't affect the chart, but just lets you see when a color is in use on screen. 

Highlight Stitches of the Active Thread  
If you choose this option, any stitches using the current drawing color will flash alternately 
black and white on screen, allowing you to see at a glance where a particular color has 
been used. 

Search and Replace 
This option allows you to find 
stitches of one or more colors (the 
list is ‘multi-select’) , and replace all 
these stitches with another color 
from the bottom list. 
(To replace a color by cloth, use 
‘Remove All Stitches of Active 
Thread’) 

 

Replace Active Thread With... 
Using this option, you can quickly exchange a color in the palette by another thread 
chosen from any list available. The palette and screen will refresh to show the changes. 
 
Blend Active Thread With... 
Sometimes, for effect, you may wish 
to work with two different threads in 
the same needle. This is known as a 
blended thread. 
To create a blended thread, click on a 
solid color in the palette, then choose this menu item (or choose it from the popup that 
appears when you right click on the palette itself). 
Select a different color from the color selector.. this can be from any range. 

The palette will change to show both color numbers, with [+] between them. 
The color sample will show half one color, and half the other, as in this picture. 
Stitched views of this color will mix lines of both colors in the same square. 

Remove All Stitches of Active Thread  
This option removes all stitches from the design that use the current drawing color.  
However, the thread color remains in the palette for later use. 

Change All BackStitch to Current Thread 
If you have a lot of backstitch and cannot recall what color was used, instead of deleting 
it and recreating with a new thread, you can use this option to set all backstitch to black 
or some other color, with one click 
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Remove Active Thread from the Palette  
All stitches that use this color will be removed from the chart. The thread will be removed 
from the palette completely. The chart is then redrawn. 
 
Remove All Unused Threads from the Palette  
All threads that are not in use in this design will be removed from the palette completely. 
The chart is then redrawn. 

Remove Duplicate Threads from the Palette  
If the same thread occurs twice, this option will replace all stitches of the second entry by 
stitches of the first, and remove the duplicate from the palette. 

Reduce Color Count by 10% 
Too many colors? This option will find the least used 10%, and replace them with closest 
matches from the remaining threads. Then it will delete the unused ones. 

DeSpeckle  
This option finds stray single stitches of a color close to other colors, and replaces the 
stray stitches with a color from nearby. 

ReOrder the Palette 
After new threads have been added to the palette, the order in which the colors appear 
may not follow a logical sequence. You can 
use this option to re-order the palette into 
something more useful.  
The following dialog is displayed: 
 
You can sort the view by clicking on any 
column heading, and thus sort by usage, 
number, name, brightness, color, and so on.  
In addition, you can drag and drop rows into 
any order you want.  
When you close the dialog using OK, your 
chosen order will be applied to the current 
chart.  

Histogram  
This shows you how much of each color has been used. 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Check Stock… 

Everyone has some thread ‘lying around’, and especially people who create packs for sale. 
Consensus is that the most common way of thinking of these is in terms of ‘Skeins’ 

The Check Stock screen is a way to records what stock you have, see what ‘this chart’ 
requires, and create a quick ‘shopping list’ where you need to deal with missing threads. 
The screen looks like this: 

The number and description shows any stock you have previously entered , in the ‘Stock’ 
column. Click on the number to edit and amend that. 

If the current chart contains threads which were not already in the list they are added 
when the screen is opened, and remembered for the future. 
The amount of thread used by each color in the list (expressed in skeins), appears in the 
‘Current’ column, and if the value needed is less than you have ‘in stock’, the current value 
is shown in Red. 

The order column always opens blank. Look down the list, decide if you need to buy any 
threads, and for each, type in the number of skeins you want to buy, or click  ‘Suggest’ 
and the app will add these for you. 
Then click ‘Shopping List’, and a list of the threads will appear, ready to be printed, 
emailed, or copied as you wish. 

 - �49



Save Current Palette as Default 
Literally saves the current palette with the name ‘default.palette’. 

When first installed, the default palette is formed from DMC shades. You can add or 
remove threads to this, replacing all by Anchor for example, and save the new list as the 
default. 
This palette (selection of color) will then be used for every new design you begin. 
 
Save Current Palette As.. 
Saves the current palette with a name you specify. Palettes must have a name with an 
extension of ‘.palette’ if the program is to recognise them in the future. 
Load a Palette 
This is only available before design work begins, because loading a new palette while a 
design is visible would (at best) make the design colors all go wrong. It allows you to 
open a selection of threads which have been saved as a .palette file, not the full list of 
threads in a range (the .threads files) 

Merge another Palette  
If you have started a chart and wish to add the colors of another palette, this option lets 
you bring another set of colors into the list. 
 
Convert Design Into...     (another make of Threads) 
This option allows you to remap the threads in the current chart, to those from another 
manufacturer’s range. 
The mapping is not done on the basis of published conversion charts, but is based upon 
comparing the actual color definitions in the threads files.  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The Markup Menu

Hide Markup 
If you have added any markup to the design, this option lets you hide it temporarily. 

Remove all Markup 
This option deletes all the markup from the chart, wherever it is. 

Markup Color 
By default, markup is a tick on a green background. You can use this option to change the 
color to one you prefer. 

The Import/Export Menu

 
Here, you can import and output a chart in a variety of ways. 
Image Import Wizard  
Advanced : Import a picture/ Import from clipboard 
See Image Import 
 
Open PC Stitch Files... 
With this option, you can open .PAT files created using PC Stitch versions 4,5,6, and 7 
which you have downloaded from the internet. 
(PCStitch 10 and 11 can both export the patterns in V7 format, so if you own a copy, it is 
possible to take a later pattern and make it compatible.) 

Files created using versions after V7, or PAT files created by Hobbyware (an early version 
of Cross Stitch Designer), will not work here. Please contact us if you have some charts 
that cannot be opened, as we may still be able to help. 

Export (PDF)  
See Export PDF 
In the Premium edition, there is an advanced PDF export facility, producing high quality, 
editable PDF documents. 
In the Standard edition, you create PDF files by going to the print dialog, and choosing 
‘Export to PDF’ from the print toolbar. 

Export as Stitched View 
This generates an image of the whole chart in ‘stitched view’, and allows you to save it as 
a PNG file. 
Export as Thumbnail View 
This generates an image of the whole chart where one stitch = 1 pixel, and allows you to 
save it as a PNG file. 
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Output as Tunisian Crochet... 
Tunisian crochet is a form of embroidery involving stitching over and into existing crochet 
work. 
Unlike cross stitch, the stitches are not exact squares in shape, but instead slightly taller 
than they are wide. 
Charts for these designs are output as a list of instructions, rather than a symbol chart. 
 
This dialog allows you to output such as design, and can compensate for the off-square 
shape of crochet stitches if you wish.  

The compensation can be either by 
removing a rows or two from the 
design, or adding extra columns. 
This choice is the ‘Method’ drop 
down at the top of the window. 
(If you have been designing and 
viewing using the new feature which 
uses rectangular grids, you may not 
need to adjust at all.) 
 
The instructions can be Corner-
to_corner (C2C),  left to right, right 
to left, or an alternation of these.  
Choose your direction preference 
using the ‘Order’ drop down choice. 
Each stitch can be identified by a 
color block, the thread number, or 
name, or its place in the palette. 
This selection is made using the ‘Identifier’ drop down on the window. 

Choosing the ‘TXT’ button produces a text file with instructions which you can print or 
format as you choose. (Unless you select ‘color block’ mode, because that can only go to 
a printer) 
Choosing .PDF sends the output to a PDF file using the page size chosen, which you can 
print or use on the web. 
Here is an example of the output for C2C in color block mode: 
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Crochet preferences. 
 

There are many things about the 
output of crochet charts that 
people and to change for their own 
needs. (There doesn’t seem to be 
a common standard for these) 
So the preferences tab allows you 
to change things. 
You can add/change the title. 
Add freeform notes. 
‘Before’ is a line of text that 
appears before the chart - ‘After’ is 
a line of text that appears after the 
chart. 
The Margin and Size options 
govern the layout of pages when 
the PDF is generated in modes 
other than ‘color block’ 

The Swap area allows you to 
completely change our wording to match your own needs. For example, if you don’t like 
{} as brackets, you can change them or remove them completely.  If you prefer to say 
‘bobble and sc’ for bobble charts, enter that text against the Bobble row, and so on. 

If you want: 
To take a cross stitch pattern and output it exactly as it stands, with every stitch, choose  
• Do Nothing 
• Alternate L/R or R/L 
• Bottom to Top 

To take a cross stitch pattern and output it as a bobble chart, with every stitch, choose  
• Do Nothing 
• Alternate L/R or R/L 
• Bottom to Top 
• Tick the Bobble Chart option 

To take a cross stitch pattern and output it while keeping the shape, by losing some 
stitches, choose  
• Remove rows 
• Alternate L/R or R/L 
• Bottom to Top 

To take a cross stitch pattern and output it as a C2C chart, choose 
• Do nothing 
• C2C 
• Bottom to Top 
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Key to CSV... 
This option saves the key/legend as a CSV file, with the numbers, names, stitch count, 
and estimated length. 
You can insert the symbols into a document either by copying them from screen , or using 
the symbols.png file in the support folder. 
A CSV file is a purely text file, and does not contain the symbols or actual colors in color. 
 
Export as Stitched View 
This option saves the whole chart in one image as a PNG file  
An image of this kind can only be detailed if the chart is smaller than 250 x 250 stitches. 
Above this  size (for instance 500 x 500 or larger), we would need to create a picture that 
used more than 4Gb of memory. 
Our program cannot access that amount of memory, and most other programs would not 
be able to open such a picture. 
So for larger images, we reduce the size of the stitches smaller and smaller to keep the 
file size down. 
It is better to use PDF for large charts. 

Exporting to PDF (Premium edition )

If you need to get the best possible output quality, to send or sell charts via the internet, 
or to send designs to a Printer, you are likely to need a PDF version of the design. 
There are 2 ways to obtain PDF files : the Import/Export option is the highest quality, and 
contains editable content.  But it is only available in the Premium Edition. (Standard 
edition has a PDF option in the print settings screen.) 

A chart exported in this way has up to 6 sections, accessed using the list on the left. 
 
The order that the sections appear in the PDF file are: 

• Cover (and Footer) Page (optional) 
• Preview Page (optional) 
• One or more Chart pages (with optional key-per-page) 
• Page Map (optional) 
• Thread Sorter (optional) 
• Symbol Key Page/s (optional) 

 
But because the optional parts are less important than the chart itself, the PDF export 
screen is in a slightly different order. 

Cover Page/Footer Page 
The first section allows for a cover and/or footer page: This allows you to have a first 
page like a book cover: perhaps this contains your logo, or any other information you 
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want to add. 
You create the cover page in any tool you like, and save it as an image file (JPG/PNG/GIF/
TIFF…) or as a single page PDF file.  
Using the … button you can browse for that image.  
As long as the program can extract an image from the file you choose, it can be used as 
the cover page. 
The same goes for the footer page, except that it forms the LAST page of the export, and 
might be used to add stitch diagrams and extra design info. 
Preview 
The next section is a Preview: This allows you to have a first or second page which shows 
the whole design on a single page.  
The default view mode here is 'Stitches' because this is designed to look like the final 
stitched work. 
If you choose 'None' from the selection box, no preview will appear in the PDF file. 
Framed view calls up the framed view window, and here you can create a preview that 
also has a framed surround. 

Here, you can also tick the ‘Page Map’ option if you want an extra page showing how the 
pages should be arranged. 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Chart 
The next section is the chart itself. 
You can choose from all available view styles for the output. 
Key 
The next section is the key to symbols. 
You can choose to have one or not, by checking the 'Key' option. 
The other options allow you to choose how the key is built up: for instance you can 
choose to have the program display an estimated length, or a count of the stitches, using 
the checkboxes available.  

Sizes
 
On the Sizes tab, start by 
choosing a paper size.(eg A4) 
 
You can choose to put the ‘entire 
chart’ on a single sheet by 
dragging the slider all the way to 
the right, but if you choose that 
option for a large design, you 
should expect the printed squares 
to be very small. 
 
(The output is ‘squashed’ to fit the 
page.) 
 
You should choose the number of symbols you want across the page (using the slider or 
text box), and the program will calculate the correct output size for you. 
(If you want to create charts with symbols which are about the same size as in 
magazines, you should aim to create pages that have no more than 70 x 90 squares on a 
sheet of A4 size.) 
 
The margins boxes allow you to set white space around the exported design. 
‘Only export the used area’ omits the white area of unused design. 

The Overlap option determines how much of the previous page is repeated on the next 
page, and clicking on the colour block next to that determines what colour the overlapped 
area will be shown as. 

(nb Thumbnails: While you work, to see a thumbnail view of the pages that 
will be generated, click the small ‘eye’ icon and the screen will generate 
thumbnails in the background and work out how many pages you will get.  
On a large design that can take a second or two.) 
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Style

On the STYLE  
tab, you 
choose how 
the main chart 
area will 
appear. 
 
You can select 
to have the 
chart as black 
and white 
symbols, 
colour 
symbols, 
stitches etc , 
using the drop 
down list at 
the top. 

 
 
The Grid option allows you to decide if there is a grid or not. 
And the thick/thin line width options allow you to set how different the thick and thin 
lines are.  (The colour blocks next to these can be clicked upon to change the colours of 
the grid lines.)  If the ‘Dashed’ option is ticked, the thin lines will be displayed as dashed 
lines. 
'Row/Column' marks the edges of chart with row and column numbers. (If ‘Bottom to 
Top’ is ticked, the number sequence starts at the bottom and works up.. useful for 
Knitting or Crochet) 
‘Page Number’ determines whether each page is numbered or not. 
'Print Centre Marks' puts little arrows at the center points of the chart. 
‘Title’ places your copyright at the bottom of each page. You can amend it here if you 
wish, or forgot to add one earlier. 
'Copyright' adds the chart title at the bottom of each page. You can amend it here if you 
wish, or forgot to add one earlier. 
Backstitch line endings can be normal, blocked, or circled, using the options at the bottom 
of the design. 
BackStitch lets you set the line end styles for backstitching. 

Starting with the 2018 edition, symbols are now exported as scalable characters. 
This gives fantastic clarity when zoomed in compared with previous versions, and you can 
also select and highlight the characters in a PDF viewer for stitching from an iPad or 
phone if you like! (The font used is copyrighted Ursa Software 2017/8 and not for free 
distribution or use in other cross stitch applications. Contact us if you have any queries) 
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Preview Page

 
On this tab, you choose whether there will be a preview page at all, and in what style it 
will be displayed.  
You could also  click the Framed View button, and create an image of the chart 
surrounded by a frame, using the existing Framed View dialog. (See the View Menu for 
more details about how that is used) 

Tick the ‘Add a PageMap’ option to insert a single page that displays thumbnails of each 
page , in sequence, with numbering to show how they all join up. 

(The Pagemap is what we use on the Thumbnails tab to show you a preview of the PDF) 
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Cover Page

 
On this tab, you choose whether there will be a cover page., and if so, you can use the 
[...] button to browse for the image to use. 
The cover page will be the first page of the PDF if it is present.. you might use this to 
make your charts present a common branding, for example. 
You can ‘insert’ a PNG, JPG, or another PDF to be the first page of the exported PDF.  
This allows you to put in a standard copyright page or logo of your choice. 

 
The Footer page option is the same, but as a last page of 
the PDF. 

Thread Sorter  allows you to insert a page (or or more) 
that gives a simple list of the thread colors - they can be 
printed on card or glued to a commercially available plastic 
sorter. 
The colors should be 1/2 inch apart when exported.  

The thread sorter can have 2,3,4, or 5 columns and looks 
like this: 
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Key

 
 
You can choose to have one or not, by checking the 'Key' option. 
If the design has less than 40 colours, you will also have the option to have a small key 
on every page instead of the fuller key at the end, using the ‘on every page’ option. 
The other options allow you to choose how the key is built up. 
Tick the options that you want to appear in the key. 
 
As you select items, you will see the key build up in the list at the bottom of the screen. 
The title of the comments column (which will display the extra description used for 
the threads if one is present) can be amended. 
(Some people want a simple ‘add your own notes’ column.  
By changing the title here you can set what is printed at the top of the column.) 
 
You can amend the text in any of these rows: just click in any cell and start typing.  
In this way you could change the estimated length to a number of skeins, add notes to 
suggest blended threads, or other tips. 
 
The respective widths of the columns can be adjusted by dragging the column headings.  
 
The Subtitle option is pre-filled with the size of the design, and your choice of stitches-
per-inch. but you can overtype this with anything you wish.  
These words appear under ,(or instead of) a title on the key page. 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In the exported key, if a colour has had a backstitch dash pattern defined for any colour, it 
will appear under the colour sample in the first column instead of the normal colour 
sample. 
e.g DMC 524 in this example uses backstitch defined with a pattern of 1:1 

 

Thumbnail View
On this tab, you can see a thumbnail view of how the chart pages will appear. 
It is a rendering of the page map that you can optionally add to your PDF. 
Note: for large charts this can take a few seconds to create, and the window will be 
unresponsive while that happens. 
The page map is recreated every so often if you have made a change to the settings. 
If you do not need to see the page map, you can stop this rendering from happening by 
unticking the checkbox next to the word Thumbnail view. 

Other
On this tab, you can amend the embedded data that is saved within the PDF itself.  
This data is not printed, but will appear as ‘information’ when interrogated by a PDF 
viewing application. 
The PDF & ZIP option can be ticked..  
If it is ticked then after the export occurs, the program will also zip up the resulting PDF 
file to compress it , ready for emailing if you wish. 
The ‘compression’ setting governs how much detail would be lost when embedding 
pictures in the PDF. 
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Color Choice

This screen gives you a lot of control over the colors of symbols and blocks. 
Each color can be individually tweaked to output in one of 5 ways. 

For example, a white thread would be invisible when printed in color, so you might set an 
alternate color of blue on the white thread (using the ‘edit this thread’ option) , and so 
choose to tick the ‘Alt’ column 

Or you may want a chart where the symbols print in pale versions of their colors: click the 
first tick under the ‘Pale’ column heading to do that. 

You might want a PDF that only shows some of the threads in color, while the rest are 
grey…Tick the top of the ‘Grey’ column, then individually tick the ‘Normal’ option for the 
colors you want to see in their real state. 

Set something to be white to render it invisible in block 
mode,  or outlined only if a symbol. 

When symbols are used, the character shapes are 
surrounded by a thin black line for clarity, whatever 
their color, and remain sharp no matter how large you 
zoom in. 
The symbols can be selected and highlighted in a PDF 
reader if you like to work from a tablet. 

 - �62



Importing Images: The Import Wizard

MacStitch and Winstitch offer two methods of importing images: 
The first is a simple 'wizard' method, which asks a series of questions and generates a 
new chart at the end. This is available in the Lite and Standard editions. 
The second is a more advanced dialog which offers greater control over the import 
process. (Premium edition only) 
 
The Wizard is a simple step-by-step process, and will choose a range of colors from one of 
the manufacturer's ranges up to a maximum number you specify. 
 
The Advanced option also allows you to fine tune the process, and can additionally force 
the import to be performed using a palette of threads you have previously saved. (This is 
the best method for importing clip art images which have a small number of colors). It 
also allows you to preview the effects of your choices before you commit to import the 
image.  
It also contains an image editor which gives you control over a variety of image 
enhancements before import. 

When our application opens, one of the options on the ‘landing page’ is the Image Import 
Wizard. 
Thats a good place to start, so click that button. 

 
 
The image import wizard starts like 
this: 
Use the 'Select Image' button to open 
an image you have previously saved 
on your computer. 
Click ‘Next' 
 
The image you chose will be shown, 
and the dialog now shows options 
that allow you to set the size of the 
final cloth. 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Here, for the purposes of 
demonstration, we have selected a 
dark image, where the subject is only 
part of the whole. 

Drag the slider for cloth until it shows the correct holes-per-inch for the cloth you 
intend to use. 
 
Then drag the large slider control until the sizes shown are correct for your finished 
cloth. 
For example, if you are using 14 hpi cloth, and want a finished piece measuring 6 
inches or less, drag the large slider until the dialog shows '...which is 6 inches ' or 
smaller. (Note: if you select a size smaller than 80 stitches, the dlalog will warn you 
that your final image will lose a lot of detail, and look blocky)  
Click the 'Next' button 
 
Now, select the number of different thread colors that the program is allowed to use. 

!  
The more colors, the more 'life like' your photographs will look. (But the harder they will 
be to stitch)  
Fewer colors means less detailed shading, and some colors will be lost – especially those 
around the outside of the design. (The program treats the centre of the design as more 
important than the edges) 
(You can choose between Photo and Clip art.  
Photo will use dithering to give a more realistic image.  
Clip art tries to keep colors solid.) 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Click 'Next'  
 

Select your preferred thread 
manufacturer. 
Now, click Done. 
After a short wait, a new design 
window will open , containing your 
imported image. 

Refining the Results
PROBLEM:  If you have a similar picture, and followed those 
instructions, you may well get an image which was too dark 
and too small to make a good result. 

The instructions above deliberately over simplify the process, 
to illustrate what can be varied during the import stage to get 
better results.  Sometimes you need a few tries to get the 
best picture. 

So, how can this be improved?  
The advanced image import option has lots of options that help here, but for this page we 
will cover only what is possible in the Image Import Wizard. It is quick but not as flexible. 
 
1: The image itself. 

The face is only a small part of a larger image.  
So when deciding what colors to apply to the conversion, a lot of our 
available range is being used up to draw background and unwanted detail, 
such as the table and the plates. 
 
Step 1 is to crop the image to just the subject area, like this image on the 
left. 

Step 2 is to increase the brightness and contrast a little. 
This can be done using most image editors. 
See the image on the right.. 

Step 3: Import again, and using the exact same settings as before, you can see the 
difference very easily: 
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!  

So by removing the background, we have allowed more colors to be used for defining the 
face, and the face occupies the whole frame, which means more stitches , and therefore 
more detail.  The moral is: it pays to experiment, and do not assume the first thing you 
try is the best you can do!  If the results are not what you expect, try other settings and 
sizes, or consider using the Advanced option where available. 

Importing Images: Advanced Import

(Premium edition only) 
Using Advanced Image Import, you can also browse your computer for a saved picture, 
and turn it into a chart. This can be a photo or clipart, in any format that your computer 
understands.  
Typical file formats include JPG, GIF, BMP,TIFF, and PNG files  
As an alternative to browsing your computer, you can import an image that has already 
been copied to the clipboard.   Then, this dialog is displayed: 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Preview:  
If you select preview (available if using 60 colors or less), a new window will open 
showing how your choices will affect the final chart. (If you have chosen to restrict to Max 
Colors = 5 , the preview will be in 5 colors, for example.) 
You will see that restricting the colors makes a 
big difference to the design, as does the size.  

For instance, if you take the image of the toucan 
shown here, and import it using the default 
palette, which only has a fixed range of colors, 
while reducing it down to about 40 x 40 stitches, 
the result will be much blockier. 
 
 
Edit:  
The image itself can be adjusted using the small up/down arrows under the image. Here, 
you can tweak how much red, green, or blue the image contains, or adjust the brightness. 

 
 
! Flip image L/R  
! Flip image upside down 
! Make image sepia toned 
! Make image greyscale  
! Sharpen image  
! Soften Image  
! Rotate Image  
! Adjust Red 
! Adjust Green 
! Adjust Blue 
! Adjust Contrast  
.. and the Reset button reverts the 
image back to the original state. 
 
 

Mask the Image:  
You can use the mouse to select an area of the image only―to crop in to someone’s face, 
for instance.  
This is a quick way to do most of the background removal you will want to do for a photo. 
 
There are 3 ways to mask the image: 
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Rectangular Mask:  
Drag the arrows until you have selected the correct area

!  

Oval Mask:  
Drag the arrows until you have selected the correct area 

!  
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Freehand Mask:  
Use the mouse to draw all around the area you want to keep. When you release the 
mouse, your selected area will be shown selected in red. 
If you make a mistake, just click and start drawing again. 

 

�  
 
Settings
Import Size:  
At the top right of the dialog, you can set the final stitched size of the imported image.  
Slide the controls for width until you have the cloth size you want.  
The values are affected by the holes-per-inch setting below. 
 
Border:  
If you choose a value here, the imported image will appear on a chart that has a blank 
border around it, of the size you choose. 

Using These Thread Colors:  
The program is shipped with several ranges of manufacturer’s threads. Choose the one 
you prefer from the list. The program will choose threads from this range, up to the 
maximum number you select.  
 
Importing can also be done using a palette you have previously saved. If you choose this 
option, the image will be mapped to the closest colors that can be found in the palette. 
(This is a useful technique for clip art images: if you have a palette made up of only 4 
colors, your final design will only have the exact colors you specify.) 
 
Max Colors:  
This governs how many different threads the program is allowed to use to represent your 
image. It is usually best to allow many colors initially, and reduce them manually 
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afterwards, as too few colors here will result in a blotchy image. 
If you import using a .THREADS file, this slider governs how many threads the program is 
allowed to ‘buy’ to complete your chart. 
The slider has no effect if you import against a .PALETTE file, since in this instance, you 
are effectively saying ‘I only have these threads―what can you do with them?’ 
Dither (Photo):  
Tick this box if you are importing a photograph, as it will make a more lifelike image. 
For clipart and other sold color pictures, leave the box unticked. 
Saturation:  
Importing an image tends to make the colors slightly duller. The saturation option makes 
the image colors deeper and more vibrant. Any value greater than zero makes the colors 
stronger. Negative numbers make the image paler. 
Import as Stitches/beads:  
By request, this feature allows you to import the image and turn each pixel into a bead of 
some color, instead of a full stitch. 

Tips for getting the best image:
Photographs contain millions of dots of color to give you the best possible printout or view 
on screen. Even one which is 6 inches across can be expected to have thousands of pixels 
in each direction.   Cross stitching is a much coarser medium, that does not strictly lend 
itself to representing photographs. Each inch of cloth has perhaps 10 to 20 stitches to 
use, and it is obvious that for every 1000 pixels in your original image, you may be able to 
stitch one single stitch. Lots of detail will be lost. 
 
Similarly, your photo has millions of different colors, but you need to stitch the picture 
using perhaps 45 different thread colors.  
So lots of shading will be lost.  

To compensate for this: 
• Your image needs to be bright and punchy. 
• Don’t waste thread colors on a busy background. 
• Crop your image so that what you can see is mostly what you want to stitch. 
• Keep the contrast high. 
 
Removing Background:  
We usually find that if you can replace the background area with a good solid color before 
you import, it is much easier to remove the background after it has been imported. (You 
can simply remove stitches of the background color) 
If the background is ‘busy’ then it will need to be erased.  
Use a mask to eliminate most of the background. 
Then after importing, remove the last edges. 
 
Using the freehand mask tool will remove a lot of unwanted background, but if you find 
there is still a lot to remove, the best way to do this is to switch to erase mode, and draw 
rectangles around the image.  
When most of the background has been removed, switch to ‘single stitches’ mode, and 
remove individual stitches to finish the job. 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Working with Plastic Canvas

Drawing a chart for use on Tapestry and Plastic is very similar to working with normal 
cross stitch, except that the stitches are ‘tent’ stitches, either left to right, or right-to-left. 
 
When you start a Plastic chart, the toolbar will only display 
two display styles: color blocks and tent stitches. 
Tent stitch view looks like this: 

Stitching is added in the same way as cross stitch.   
The blue (hashed) area is ‘nothing’ (it is meant to represent perhaps your desktop.. the 
texture can be changed by replacing the background.png file in the support folder)  
The white grid is plastic canvas. (color can be changed) 
 
You are not strictly restrained by the canvas area you 
have on screen: if you draw stitches over the blue 
area, the canvas will be extended to match. 
You can add canvas and background in the same way 
as stitches: just choose them like ‘colors’ from the 
palette. 
Tent stitches will default to this direction: ///  
You may want to have stitches in the opposite direction, for effect. 
Each color in the palette can be stitches of a single direction only. 
If you need red stitches in both directions, add the thread to the palette 
twice. 
 
To change the stitch direction, select the thread, then edit the thread by clicking on the 
status bar at the bottom of the screen, where the name is shown: 

!  

This opens the thread 
editor window, and there 
are extra buttons when 
you are working on 
Plastic, shown next to 
the ‘Strands’ option, and 
under the ‘Number’ 

Simply click the direction 
button you want to use 
(next to the Strands 
selection) , and click 
‘Done’ 
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Preferences

The preferences dialog allows you to set program-wide defaults for a variety of choices, 
which are not expected to change from chart to chart. 
The dialog looks like this (options vary by operating system): 

 
Show Context Help 
When ticked, a help window will be visible showing a web page that is relevant to the 
action you are performing. 
Use Metric Measures 
When ticked, the rulers, thread estimates, and page sizes displayed by the program, will 
appear in Centimetres (SI units) rather than inches.  
Allow REDO after UNDO  
If this is ticked, then the program will store away a file called REDO.chart when UNDO is 
chosen. This allows an UNDO operation to be reversed. If unticked, the REDO menu 
option will be unavailable. 
Copyright 
You can type a copyright notice here and it will be added to each new chart you create. 
However, it can then be changed for each chart later. 
Dither 
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When importing images, a small number of colors can be used to represent shading, by 
‘dithering’. This option lets you choose between some common dithering methods. We 
prefer Floyd Sternberg, but you may prefer something simpler. 
Toolbar Captions 
The main toolbar can be captionless, or it can show short descriptions, or the keyboard 
shortcuts used to activate each button. You can choose which using the drop down here. 
BackColor 
This is the color shown in the unused space around the grid on screen.  
Palette Color 
Some people prefer not to have ‘full white’ areas on screen for long periods. This option 
lets you set the background of the palette to a grey, to avoid ‘screen burn’ 
Default Strands 
This is the number of strands assumed for any new thread you add to the palette. 
Show Centres of Motif when pasting  
When this option is ticked, the centre of a motif will be shown with cross–hair lines , to 
allow you to line the motif up with specific places on the chart. 
Always Paste as a Layer 
If available, when this option is ticked, then pasting a motif will promote it to a movable 
layer instead of pasting immediately into a chart. 
To make a layer permanent, click the flatten icon next to the layer in the layer organiser. 
Image Layers retain original Shape 
If you insert a picture and resize it, this option determines whether you keep the actual 
shape you resize it to, or whether it self-adjusts to keep the original image shape. 
Stop on First Click After Paste... 
If this is ticked, then when you PASTE an item (not a layer), or FILL an area, the program 
reverts to full stitches mode. If this is unticked, the program will continue to paste until 
you click another toolbar button. 
Scroll Grid when near the edge 
If you hold the mouse down and draw near the edges, this option means the grid will 
scroll to let you get at nearby areas. When unticked, it doesn’t. 
Keep selection after Paste 
When ticked, if you paste an item, the original area remains selected so you can do other 
things with it. When unticked, the paste causes the app to ‘forget’ you had anything 
selected. 
Copy picture to clipboard  
If this is ticked, then when you select an area of chart and choose ‘copy’, a picture eof the 
visible grid will also be copied to the clipboard for pasting into another application if you 
choose. 
Show Some Cloth Through Stitches 
This option governs whether there is a little cloth cold shown behind each stitch when in 
stitch view. If unticked, crosses will be shown as solid - no cloth is visible behind. If 
ticked, you can see cloth color behind black stitches. 
Example of the difference: 

! !  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Tent Size 
Tent Stitches can be tick or thin. Thicker lines make the design look more colored, where 
thinner ones make it easier to distinguish individual stitches when printing in color. 
Thin gridlines dashed 
On the mac, the thin gridlines on screen may be dashed or solid. 
Zoom out when pasting 
If the thing you are pasting is bigger than the visible area, this option causes the zoom 
size to be reduced so that you can see the whole pasted item when you paste it. 
Save charts in old format 
This option will rarely be used: it forces the program to save charts which are backward 
compatible with X-Stitch Studio or early MacStitch versions. The old format takes up more 
space than the current one, and can not include beads, text fields, buttons , layers and 
other recent features. This is only of use for sending a .CHART file to someone with a 
really old version of our software. 
Use Old Symbols 
A new set of symbols were introduced in 2018. If you have a chart made in an older 
version that you need to rework and keep the same symbols, tick this box and untick ‘TTF 
Font’ while you are working. That will switch back to the old symbol set (but you will not 
get the scalable font in the PDF export) 
Zip Archive 
If this is ticked, then when you save a chart, we make a zipped copy in the documents 
folder as a safety net. If you ever lose a chart, or need to revert to an old version from 
weeks ago, this is a way to do it. See ‘recover file from archive’ to get the files back. 
It has a small impact on the time taken to save, but we feel it is worthwhile  
Print with an overlap  
This option lets you choose how much overlap (if any) is used when printing a multi-page 
design. Overlapped areas contain repeated items from previous page, under a greyed 
area. 
Print Centre Marks 
If this option is ticked, small marks will appear around the design when printed, on the 
lines that represent the exact centre of the design. 
Backstitch prints as black/grey  
By default, backstitch will print in the thread color, if you have a color printer. 
Obviously, it will print in shades of grey on a black and white printer. 
If this option is ticked, then backstitch will also print as black/grey on a color printer. 
Backstitch Thickness  
This allows you to set the comparative thickness of the backstitch lines when printed. If 
the lines are too thin, reduce the number shown. 

(PDF) Outline special stitches 
The ‘special stitches’ (3 x 2, 3 x 3, petit point) will normally be shown on the PDF output 
with a thin border because they could be placed over an existing normal stitch, and the 
outline will show them more clearly. 
Untick this box if you want no special outline. 
TTF Font 
From 2018 onwards, the Advanced PDF export can use scalable vector characters for 
symbols into the PDF. This is intended for use when opening the PDF on an iPad or similar. 
(Some PDF viewers do not print such symbols properly unless instructed to ‘print as 
image’)  If this causes any issues, untick this box and picture symbols will be used instead 
(the way 2017 and earlier worked) 
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Color behind Symbols 
In the PDF key, when you have black symbols, ticking this box will put a color block 
behind the symbol for reference. 

Chart Folder 
Normally, you should save your charts in Documents/Macstitch or similar  
If you select another folder here, the program will open in your chosen folder when you 
go to save. 
Logo  
If you want to have a logo (a picture representing your business) embedded on the chart, 
set the path to the picture here. 
You can select an area and ‘Insert Logo’ when creating your chart. 
This option is largely obsolete now that Layers allow you to insert an image anywhere on 
the chart. 

Preferences (Estimated Length)

Thread Estimation Factor 
The program has built-in values 
for how much thread will be used 
for each stitch. These values take 
account of the holes-per-inch 
setting of the cloth. If you find the 
program’s estimate of thread 
usage varies from your own, you 
can vary the estimation factor 
here by changing the value.  
The value shown is the length of 
thread used per stitch. If you are 
stitching with 2 ply or 3 ply, this is 
the length of the 2 ply run. 
 
If you need to know when a skein 

or spool will run out, you need to 
see the amount vary by the number of strands you use. 
So 12 inches using 2 strands is 24 inches of single strand. To make the program use the 
24 inches version, tick the ‘multiply length by strands’ option. 
Unticked, 12 inches of 2 ply will report 12 inches.  Ticked, 12 inches of 2 ply will report 24 
inches, and 12 inches of 3 ply will report 36 inches. 

Preferences (Thread Sets)
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The thread sets page lets you hide some of the bundled threads without deleting them, if 
you don't want to bother skimming through unwanted manufacturers ranges in the 
thread-related dialogs. 

The Use for Motifs column lets you select one range of threads for use with Motifs. 
When a motif is pasted, it is converted to use this set of colors, before being added to the 
palette. In this way you don't get DMC colors added to an Anchor chart, or vice versa, just 
because the motif was saved with ‘the wrong colors’ when created. 

Preferences (Discontinued threads)

Here you can maintain a list of threads you do not want to use when importing:  
(when threads are discontinued, you won't want to make up kits in colors you can no 
longer buy_) 

Recover File From Archive.. 
(Found in the Application menu on Mac)  
Every time you save a chart, the application makes 
a zipped copy in your documents folder as a 
backup. 
(set using Zip Archive in the preferences screen) 
 
Should you ever mislay a chart, or lose your work 
by accident, a copy of the chart should be 
available inside the zip archive.  
To make it easy to get an old file or version back, 
use this option. 
It will search all archives it can find in your 
documents folder, and display a list of names, sorted by date. 
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(The number is a way of ensuring that charts of the same name from different dates are 
all preserved.  In this way, you can see and recover versions of charts that have been 
developed over weeks) 
 
Click ‘Open’ to recover the chart. Remember to save it with a new name after recovery. 

Symbol Editor
(Creating your own symbol shapes) 
Normally there is no need to enter this screen. 
Importantly, this is not the place to assign a triangle symbol to a red color. (Just click the 
symbol on the status bar to do that) 
 
The 255 symbols used by the program are stored in a file 
called ‘symbols.png’  
This file is a picture, and could be freely edited using any 
image editor you own. 
Each Symbol occupies an area of 64 x 64 pixels, and is drawn as pure black on a pure 
white background. 
However, from 2018, because we use a TTF font for PDF output, you need to know that 
amending these onscreen symbols only affects on-screen and printing work. The PDF 
output may well show different symbols. 
 
In the help menu, you will find an option for 'Symbol Editor'  
This allows you to amend any or all of the symbols, to be any design you wish.  

 
You will see that this is 
a modified form of the 
normal edit screen. 
 
Click the symbol 
button (second from 
left on the bottom) to 
choose the symbol 
you want to amend. 
 
Now, you can draw in 
this grid using the 
same tools as normal. 
When you have 
finished editing, close 
the window, and you 
will be offered the 
chance to save the 
changes permanently.  
 
If you do not want to 
affect the default 
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symbols, do not choose ‘Save' 
If you want to reset the symbols back to the ones we supplied, use the triangle icon on 
the toolbar. 
(if you make a mess of the file, delete it. The program will recreate it for you) 

Adding Totally New Threads 

In the help menu you will find an option to amend for ‘Thread Editor’ 
 
The changes you make here will affect the range of threads available for every 
new chart you create in the future.  
Do not be tempted to add metallic or variegated threads into a normal range of silks, 
because this will cause them to be considered as possible threads when importing photos: 
instead create a new .threads file.  
 
The Thread Editor dialog looks like this: 

 
Choose the manufacturer’s range from the combo box at the top of the screen. (Anchor 
shown here) 
To create a completely NEW range of threads, select a thread set that resembles the one 
you want, or have a conversion chart for. Choose ‘Save As’, and save with a new name. 
Then edit the copy. 

  
 
Scroll up or down the list to see the existing threads.  
Click + to add a new one. 
Click - to remove an existing one. 
Double click the number or name to change those. 
While you have a thread selected, you can affect the color by clicking on 
the color block.  
 
When you have finished making changes, choose ‘Save’ to save the 
changes, or ‘Close’ to discard your changes. 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How Do I?

We have found it is impossible to guess all the things that people might want to do with 
our software. You are an inventive crowd! But here are some commonly asked ‘How Do I? 
questions, and there are more on our website, which we add to whenever possible. 
We also have ‘how to’ guides and videos. 
If you have a question we don’t cover, please send us an email and we can help! 

How Do I Stop pasting a motif when I’m finished?  
Start doing something different: e.g. click on the full stitches icon. 
 
How Do I Insert some rows or columns in the middle?  
Select an area. 
Choose ‘Insert <n> rows’  (or columns) from the popup menu which appears. 
 
How Do I reduce the colors after an import?  
Choose ‘reduce colours by 10%’ in the palette menu. 
 
How Do I identify a colour I have already used?  
Click on the eyedropper tool on the toolbar, and wave the mouse around over the grid. 
The name of the colour will be shown at the bottom, and click ing on the stitch will 
change to that color. Pressing the spacebar is a shortcut for this action. 
 
How Do I make the symbols on the printout bigger?  
Choose fewer symbols ‘across the page’ when you go to print. Less symbols, bigger 
symbols. 
 
How Do I delete an area?  
Use the lasso tool to select a randomly shaped area, then choose Delete or press CMD-X 
or CTRL-X 
How Do I delete the background?  
Use the lasso tool to select a randomly shaped area, then choose ‘Erase Background’ from 
the popup menu. 
 
How Do I add a new thread colour to the .threads ? 
Why is <thread number> missing?  
Use Thread Editor in the help menu. Select your range. Click the + button. Change the 
name and number. Select a colour from the popup. Save. 
We don't ship variegated , rare , or blended threads as standard, because they would not 
be good for image import. But we may have ‘suggested colors’ for them.. please ask. 

How do I change all the red stitches to green in a small area only? 
Select the area with the select tool, & choose ‘search and replace’ from the palette menu. 

How do I use this chart to drive my Embroidery Machine? 
Thats not possible. 

How do I print onto cloth? 

 - �79



The only way we know is to export as PDF in color blocks mode, and take the PDF to a 
specialist printer who can apply inks to cloth. Don't try putting cloth in your printer! There 
is also transfer paper available: you print in color on transfer paper, and iron it to cloth. 

How do I get blended colors? 
Right click on a color in the palette, and choose ‘Blend’ from the popup menu. 
The color you choose there will appear as a blend , and the number of the thread will be 
amended. 
 
How do I delete unwanted charts? 
There is no ‘delete’ option for charts in the program, but when you use file/open, the file 
open dialog will usually allow you to right click on a file, and choose ‘delete’ or ‘move to 
trash. 
You can also use Finder or File Explorer to look in the Documents folder, for win stitch or 
macstitch, and in there a folder called Your Charts Here.  Select unwanted files and drag 
them to the trash. 

How do I get more space to design on? 
Use the edit menu, choose ‘change design area’, and enter a bigger design size than you 
are currently using. 
Answer ‘no’ to ‘resize the design’. 
Then use the edit menu / Auto centre  to make the design occupy the middle of the new 
area. 

Can I scan in an existing chart and turn it into a new design? 
Sadly no. You can however use a scanned chart as an onion skin image, and draw over it 
in color. See our ‘How To’ 

I have a Mac and a PC, can I have the program on both? 
Yes.. you can get the software for your other machine just for the price of the recent 
upgrade. (usually less than £10). 
Your serial number will work for both machines. 
If you have a desktop and a laptop which are both Mac or both PC, you are allowed to 
install your software on both. 

Can I save charts in PAT or other format? 
Not from within the software itself, but we do offer a solution using some third party 
software , as a service. Please drop us an email for more information. 

Can I get the printout to be bigger/smaller? 
The print dialog has a ‘symbols per page’ option. 
The more symbols across the page, the smaller they will be. 
For bigger symbols, use less per page. This WILL generate more pages.. you need to 
balance symbol size against number of pages. 

Is there an upgrade? 
The software should tell you when updates are available, and when chargeable upgrades 
are available (the major number changes), you can buy upgrades on our website. 
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We also offer a lifetime upgrade deal where you pay once and qualify for all future 
versions forever, without any future fee. 

How do I get my finished work to be  8 inches by 6 inches? 
You need to know how many stitches per inch you are getting. 
If you have 14 holes per inch cloth, and you stitch ‘over one’, then you are getting 14 
crosses per inch 
If you stitch ‘over two’, then you are getting 7 per inch. 

28 hpi cloth , worked ‘over two’ is 14 stitches per inch. 

Now that you know how many stitches-per-inch, you need to multiply the size in inches by 
that number - this gives you the size in stitches for your chart. (ignoring any extra for 
waste) 

Here is a table of common sizes: 

If you have a chart of the wrong size, you can click the size at the bottom of the screen. 
This opens the change size dialog. 
Enter your new size, and click OK 

Example: you are stitching 14 stitches per inch, and you want 8 x 6 inches 
You need a chart of  8 x 14 = 112  stitches    by 6 x 14 = 84 stitches 

Inches 7 per in 10 per in 14 per in 18 per in 28 per in

3 21 30 42 54 84

4 28 40 56 72 112

5 35 50 70 90 140

6 42 60 84 108 168

8 56 80 112 144 224

9 63 90 126 162 252

10 70 100 140 180 280

12 84 120 168 216 336

14 98 140 196 252 392

16 112 160 224 288 448

18 126 180 252 324 504
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How do I get rid of the background after importing? 
Importing images often gives you a subject surrounded by an area you do not need. 
Sometimes that area is a nice clean solid color, usually it is a complex set of stitches in 
itself. Although you can look at the image and ‘see’ the face, dog, or whatever the main 
subject is, that is quite difficult for the computer. 
There are a number of techniques that can remove the background after import, but 
before we discuss those, it is worth mentioning that the 
Advanced Import screen does allow you to use a freehand 
Mask to choose which area you want to import in the first 
place. 
Select the freehand Mask, and draw around the subject 
using the mouse. It will be outlined in red, and only the red 
area will be imported. 

But if we don’t do that, the image will import all the 
background too. 
We can use a similar technique to remove the bulk of the 
background AFTER import. 
Zoom out as far as you can, then select the Lasso icon on 
the toolbar. 
Draw freehand around the part you want to keep. 
Let go of the mouse, and choose ’Erase Background’ 

Another technique is to erase the background using the mouse. 
Click the ‘Erase’ color in the palette. 
Choose Filled Rectangles from the toolbar. 
And draw filled rectangles round the subject using the mouse, cropping as close as you 

can. You can see the effect here, where 4 or 5 rectangles have 
been removed. 

Now, whichever technique was used, the last few stitches close 
to the subject can be removed by switching to full stitches on 
the toolbar, and the Erase color from the palette. 
And draw/erase the details . 
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